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Annotation. The article conducted a study of certain aspects of the using digital elevation model (DEM), it’s classification and methods for obtaining in Civil 3D software. A quadrocopter aerial photography of a local object (land plot with vegetation cover and the building of the educational building of NUBIP of Ukraine) was carried out with further obtaining a point cloud in Pix4D software, which was taken as basis for building the relief model.
The article proposes a classification of surfaces in Civil 3D software, their components and filling data. The article compares the obtained surfaces, depending on the source data. The errors that occur while working with a point cloud and forming surfaces using Autodesk ReCap and Civil 3D programs are illustrated. The main advantages and disadvantages of building a relief model with using data from a point cloud were discovered, and a method for eliminating disadvantages was proposed. The functions and capabilities of the Civil 3D and Autodesk ReCap software are considered. Features of constructing surfaces based on various source data are given.
A comparison of the DEM (generated using Autodesk Civil 3D software) and the topographic plan (generated as a result of total station survey) is given.
Keywords: photogrammetry, digital elevation model, Civil 3D, point cloud, coordinate geometry points.
Introduction.
The requirements of a digital elevation model have long been the norm, not innovation. Many companies engaged in the design of linear objects need in three-dimensional terrain models created in research departments. The advantages of a three-dimensional representation of the relief are obvious: interactivity, convenience in work, reduction in the likelihood of errors due to the human factor.
Digital elevation model (DEM) - representing the topographic (earth) surface during computer processing of the results of engineering and geodetic surveys.
Such applied tasks as building contours, obtaining longitudinal and transverse profiles, calculating the volume of earth masses and etc are solved with using a digital elevation model. Surface modeling processes are important not only for researchers. For example, designers, when designing master plans, solve the tasks of calculating and optimizing the volume of transported soils with using a digital 3D model of the existing terrain. And for the successful and effective implementation of the creating projects, whether it is a master plan or a road project, it is necessary to present the design solution in the form of a digital 3D model of the relief of the designing surface, because such data is vital for the operation of automatic control systems for construction equipment. Therefore, the tasks of creating and using digital elevation models are actual not only for researchers, but also for designers and builders.
Analysis of recent research and publications. Researches of this topic were carried out by many authors, in particular in the work “Digital relief models” [3]. Khromykh V.V., Khromykh O. V. An attempt is made to show the entire process of creating a digital elevation model in this student manual. Kostin A. V., - “Digital terrain model (methods for creating and areas of use)” [2], Burshtinskaya K.V. - “Theoretical and methodological foundations of digital elevation modeling for photogrammetric and cartometric data” [3] – in these works was developed methods of constructing DEMs and was represented various ways of creating 3D models.
 However, the topic of constructing a digital elevation model remains relevant, since there are a lot of software tools that can be used for building a DEM, which in its turn creates a lot of questions.
The purpose of the study is the theoretical and practical aspects of creating a DEM in Autodesk Civil 3D software based on aerial photography materials.
Methodology and research methods. During the study, a method of comparing scientific publications was used. To obtain the ability for building a surface based on our own survey data from UAVs and ground-based surveys, such software tools were used as: Pix4D, ReCap, Civil 3D.
It was experimentally established which data is better to take as the basis for constructing the surface. Corresponding processing results are given.
The results of the reseaching. The most common digital data of the shape of the Earth’s surface is digital terrain models (DEM) based on cells. These data were used as input for the quantitative assessment of the characteristics of the earth's surface.
DEM - is a raster representation of a continuous surface that usually refers to the surface of the Earth. The accuracy of this data is determined primarily by resolution (the distance between the points of the sample). Other factors that affect accuracy are the data type (integers or floating point) and actually sampling the surface when creating the original DEM.
Digital elevation models allow the following operations:
· fast obtaining information about morphometric indicators (height, tilt angle, slope exposure) at any point in the model;
· analysis of the steepness and exposure of the slopes, building on-the-fly appropriate maps;
· generation of contour lines;
· building profiles of the cross-section of the relief in the direction of a straight or broken line;
· analysis of surface runoff;
· generation of thalweg and watersheds;
· calculation of volumes;
· calculation of surface areas;
· calculation of levels and areas of flooding;
· construction of three-dimensional terrain models with the possibility of rendering and drapery of the surface both vector objects (water network, roads, settlements, landscape maps, etc.), and raster layers (topographic maps, remote sensing data);
· creation of a video image of the “span” above the model surface
· on a given route (virtual reality system);
· analysis of visibility zones from a given point or points of view and the construction of appropriate maps or three-dimensional models;
· transformation of the original model by adding new data.
A surface in Civil 3D is a three-dimensional geometric representation of a piece of land. A surface consists of these points, which are connected to each other and form triangles or a grid of the surface.
The surface model consists of the following components:
· points;
· triangles;
· border;
· horizontal;
· grid.
The visibility of any of the components on the surface can be turned on or off. Thus, for example, by creating a design surface and turning on the view of contour lines on it, you can see the vertical layout of the site. Such a layout will be dynamic and respond to all further surface changes.
As a rule, initially a surface in Civil 3D is created empty, and then it is filled with data for construction. Such data may include:
· Points of coordinate geometry COGO;
· Horizontal, structural lines;
· Simple AutoCAD objects (points, segments, blocks, texts, 3D faces, polyhedrons);
· Borders;
· DEM files (DEM files are intended for storing and transferring large volumes of topographic information about terrain in the form of XYZ coordinates of grid nodes with a constant step).
Surfaces in Civil 3D come in the following types:
TIN -surface. Such a surface is based on triangles that connect the nearest points on the surface to each other and form a triangulation network. The mark of any point on the surface is determined by interpolating the vertices of the nearest triangles. This is the most common and frequently used type of surface;
Mesh surfaces. Such a surface is based on points of the grid with a constant step. Such surfaces are used to display large spaces with low detail;
TIN surfaces for volume. Complex surface, constructed according to the difference in elevation of points of the reference and the base surface. Most often, the surface of existing land is compared with the design for calculating the total volume of earthwork;
Mesh surfaces for calculating volume. The points of such a surface are calculated as the difference between the upper and lower surfaces, with points on the grid.
Thus, having examined the basic concepts, we will go directly to creating a surface in Civil 3D. [6]
The initial data is the result of processing in the Pix4D software of aerial photographs of the educational building No. 6 of NUBIP. In order to be able to work with the point cloud in Civil 3D, export the point cloud from the Pix4D program (.xyz file format). 
[image: ][image: ]Fig. 1 Export point clouds (Pix4D Program)
When exporting a point cloud, it is possible to specify not only the format of the source file, but also select the group or groups of points that are exported. Thus, points can be classified in the Pix4D program by creating a group of points that does not have extra objects (for example, bushes, trees, houses, etc.), which can create non-existent horizontal turns.
Civil 3D does not work with the .xyz file format. The point cloud in this software can be attached in the .rcp and .rcs formats. ReCap application (it is installed together with Civil 3D) is using for converting our file to the required format. This application can be launched directly from Civil 3D on the toolbar, in the "Insert" menu
You need to perform the following sequence of actions: click «scan project» - give a name and choose a file location - click «select files to import» - select a file with the extension .xyz – «index scans» - «import files» - «launch project».
As a result of these steps, it was possible to work with a point cloud in ReCap. Now you need to "get rid" of unnecessary objects. The fairly simple interface of the program facilitates quick orientation in its functions.
Unnecessary objects can be deleted in two ways: the first - using the «Fence» tool, to remove such objects, the second - divide the objects into regions (regions) , then export the useful region without unnecessary objects (Fig. 3). 




[image: ][image: ]Fig. 2 Point Cloud in Autodesk ReCap
Fig. 3 Creating Point Regions in Autodesk ReCap
In this case, the second method was used: unnecessary objects were assigned to a separate region. Then visibility of this region was turned off. The result was "clean land", which was exported to a separate file.
[image: ]Now let's move on to the Civil 3D software, go back to the "Insert" menu and attach obtained point cloud. After that, go to the “Home” tab and select “Create surface from point cloud”.
Fig. 4 Creating a surface from a point cloud in Civil 3D software
The program created a surface (Fig. 6), but by moving the horizontals closer, it becomes clear that the model is far from ideal. Points from bushes, grass or something else could affect the result. That is, there is no way to perfectly crop the point cloud if the aerial photographs contain a lot of vegetation.



[image: ][image: ]Fig. 5 Surface created from a point cloud	Fig. 6 Horizontal contour errors
Therefore, the construction of the relief will be performed by using the COGO points created manually.
Coordinate Geometry Points (COGO) are AutoCAD Civil 3D objects that can be displayed in a drawing and that can be manipulated graphically. The appearance of points is set using point labels and point styles.
So, in the “Home” tab, select «Points» — «Create points» — «Surface» — «Along the polyline / horizontal».
This procedure requires you to specify the distance between points, a description of the point and the horizontal on which the points will be built. The description of points is necessary in order to be able to attribute these points to one group. This is necessary to set view style for this group of points, as well as to create a surface when filling process the virtual surface with data from a group of points in progress.
[image: ]
Fig. 7 Creating COGO points along contour lines
You can also create points completely manually. For this, select the command «create points manually», then click LMB on the place where we want to create a point, enter a description and height. As a result, a point will be created.
It is recommended to combine commands for general horizontal filling. Then manually deliver points where they are needed. Also, any point can be easily deleted by selecting it and pressing «delete».
The standard view of the point can be seen in Fig. 8:
[image: ]
Fig. 8 Creating COGO points 
[image: ][image: ]In order to change the view style in the Navigator, open menu «points», select the necessary group of points, click on it with RMB and select «Properties».
Fig. 9 COGO Point Group Properties
It is important to consider that after any of the points has been deleted or added to the group, it is necessary to use the Update” function located in the same options. Otherwise, the display style of added points will not change.
[image: ]Thus, a set of points was obtained that is used to construct a surface model.
Fig. 10 Created Points by COGO
[image: ][image: ]Then, on the "Home" tab, select «Surface» - «Create Surface». Specify: surface type, name, description, style and material for visualization (Fig. 11). Thus, the surface will be created and displayed on the panel Navigator. However, this surface is virtual and actually does not exist yet, because it is not filled with data. For this, on «Navigator» panel, open menu «Surfaces», select created surface, then use option «Definitions» - «Point groups» - «Add». Then, opens a dialog box (Fig. 12), in which you need to select the desired group of points and click «OK». As a result, the created relief will be shown.
Fig. 11 Creating a surface





[image: ][image: ]Fig. 12 Filling a surface with data (COGO point group)
[image: ][image: ]As a result, the following surface was obtained:
Fig. 13 COGO Point Based Surface			Fig. 14 Surface tinting
Conclusion. The ability to create surfaces and work with them today is a necessary skill. This skill allows to improve the quality of products, documentation, perform earthwork calculations with maximum accuracy and speed up the process of plots execution.
At the moment, there are many different softwares that provide DEM construction functionality. For example: ArcGIS, MapInfo, GeoMedia and etc. The choice was made in favor of Autodesk Civil 3D software. Advantages and disadvantages of this software were identified as a result of the creation of the DEM in this program, its. The first stage of surface construction was carried out in the ReCap application. 
The advantages of processing point clouds in ReCap are a fairly simple and convenient interface, as well as wide functionality. The program provides next features: deleting part of the point cloud, creating regions, exporting regions with separate files, etc. The disadvantages of this software concern the removal of parts of the point cloud. When pasting into Civil 3D, some of the parts of the point cloud deleted in ReCap may appear again, so it’s better not to delete, but to distribute points by region and turn off the corresponding regions. In addition, the removal of part of the point cloud leads to the resetting of elevation marks when building terrain in Civil 3D.
The advantage of Civil 3D, of course, is its wide functionality. The program supports vector, regular, triangulation models; data input from geodetic instruments; phototriangulation; three-dimensional visualization; automatic visualization; automatic vectorization; construction of profiles, isolines, thalwegs and watersheds and etc. However, this software makes serious demands on the specifications of the PC, since the program requires at least 8 GB of RAM. Another drawback is the processing time. Our point cloud contains approximately 2.5 million points. The processing time was about 30-50 minutes. And also after completing the surface formation, you need to wait about 20 minutes to load the results. After this time, it becomes possible to continue working in this software.
It is worth noting that at the stage of creating the surface, the horizontals obtained on the basis of a point cloud are quite inaccurate. Moreover, many small closed contours are created. Errors, when building a surface, arise quite often in the Civil 3D program. However, it is possible to correct these errors automatically. But in the disassembled case (Fig. 6), it is rather difficult to eliminate them. Therefore, as an alternative solution to this problem, the construction of COGO points is used.
When comparing obtained relief and topographic plan (Fig. 14), created as a result of total station surveys, the difference in the horizontal arrangement is noticeable. These differences may occur for various reasons. Firstly, this may be due to insufficient data availability or data imperfections, since the point cloud used in the construction was not perfect and contained gaps. Secondly, surveying with a total station is also not ideal. During its implementation, there are various factors of influence and types of errors that to some extent affect the results.
[image: Топоплан]
Fig. 14 Topographic plan
Thus, some errors are always present during processing. And, of course, it is best when the results of several types of surveys are available, having analyzed which, you can achieve a more accurate result.
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ФОРМУВАННЯ ЦИФРОВОЇ МОДЕЛІ РЕЛЬЄФУ ЗА МАТЕРІАЛАМИ АЕРОФОТОЗЙОМКИ В ПРОГРАМНОМУ ЗАСОБІ CIVIL 3D
Анотація. У статті досліджено окремі аспекти використання цифрової моделі рельєфу (ЦМР), їх класифікація та способи отримання в програмному засобі Civil 3D. Проведена аерофотозйомка квадрокоптером локального об’єкта (земельна ділянка із рослинним покривом та будівлею навчального корпусу НУБіП України) із подальшим отриманням, за допомогою програмного засобу Pix4D, хмари точок, яка і була взята за основу для побудови рельєфу.
У статті запропонована класифікація поверхонь у програмному засобі Civil 3D, їх компоненти та наповнення даними. Проведено порівняння отриманих поверхонь залежно від вихідних даних. Проілюстровані помилки, які виникають при роботі з хмарою точок та формуванні поверхні з використанням програм Autodesk ReCap та Civil 3D. Виявлені основні переваги та недоліки побудови рельєфу за даними хмари точок і запропоновано спосіб їх усунення. Розглянуті функції і можливості програм Civil 3D та Autodesk ReCap, особливості побудови поверхонь на основі різних вихідних даних. 
Наведено порівняння ЦМР (сформованої за допомогою програмного засобу Autodesk Civil 3D) та топографічного плану (сформованого у результаті тахеометричної зйомки).
Ключові слова: фотограмметрія, цифрова модель рельєфу, Civil 3D, хмара точок, точки координатної геометрії.
***
Бутенко Е.В., Боровик К.В., Герин А.Р., Губкин Б.А.
ФОРМИРОВАНИЕ ЦИФРОВОЙ МОДЕЛИ РЕЛЬЕФА ПО МАТЕРИАЛАМ АЭРОФОТОСЪЕМКИ В ПРОГРАММНОМ ОБЕСПЕЧЕНИИ CIVIL 3D
[bookmark: _GoBack]Аннотация. В статье проведено исследование отдельных аспектов использования цифровой модели рельефа (ЦМР), их классификация и способы получения в программном обеспечении Civil 3D. Проведена аэрофотосъемка квадрокоптером локального объекта (земельный участок с растительным покровом и зданием учебного корпуса НУБиП Украины) с дальнейшим получением, с помощью программного обеспечения Pix4D, облака точек, которое и было взято за основание для построения рельефа.
В статье предложена классификация поверхностей в программном обеспечении Civil 3D, их компоненты и наполнение данными. Проведено сравнение полученных поверхностей, в зависимости от исходных данных. Проиллюстрировано ошибки, которые возникают во время работы с облаком точек и формировании поверхностей с использованием программ Autodesk ReCap и Civil 3D. Обнаружены основные преимущества и недостатки построения рельефа по данным облака точек и предложен способ их устранения. Рассмотрены функции и возможности программ Civil 3D и Autodesk ReCap, особенности построения поверхностей на основании различных исходных данных.
Приведено сравнение ЦМР (сформированной с помощью программного обеспечения Autodesk Civil 3D) и топографического плана (сформированного в результате тахеометрической съемки).
Ключевые слова: фотограмметрия, цифровая модель рельефа, Civil 3D, облако точек, точки координатной геометрии.
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